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Important General Considerations
Introduction and advice for proper use of a Rainbow MSI System
The Rainbow software is designed to provide for an easy access to the setup and capture of multi-
spectral image stacks. The image stacks are captured and may be analyzed according to the methods 
of Multiband imaging or Narrowband imaging. 

In order to work efficiently and achieve good results from the use of a Rainbow product, it is expected that 
the user is familiar with the methodology of the system intended for use, be it the Multiband system or the 
Narrowband system (or both systems):

 • Multi-spectral imaging of the Multiband method works according to the Charisma guidelines for 
capture and visual analysis, specified on page 60. The Rainbow implementation uses LED light 
sources to deliver the requested UltraViolet, Visible, or InfraRed light. Charisma Ref: https://www.
researchgate.net/publication/267266175_Multispectral_Imaging_in_Reflectance_and_Photo-in-
duced_Luminescence_modes_A_User_Manual

 • Multi-spectral imaging of the Narrowband method captures and analyzes image stacks comprised 
of images captured under a wide range of narrowband lights - up to16 narrow bands, ranging 
from select UV light, throughout Visible light, and into IR light. The Rainbow implementation uses 
LED-panels to deliver the narrow bands of lighting. In combination with cut-filters on the camera, 
photo induced luminescence may be captured. The analysis of a Narrowband image stack is often 
made using statistical methods, chosen for the specific application area. This may include analysis 
of paintings, analysis of handwritten documents, or analysis for forensic discoveries.

 • The Rainbow in-line Analysis Module provides an intuitive way for analyzing a multi-spectral stack. 
Any stack (Multiband or Narrowband) can be analyzed directly in the software with the techniques 
most often used for image analysis. The functionality of the Analysis Module lets the user form 
an initial opinion of the image stacks content, useful for making decisions about the content and 
potentially for further analytical steps to be taken - typically using external software. The three 
different techniques available within the Rainbow Analysis Module for the analysis of stacks are 
“Principal Component Analysis” (PCA), “Independent Component Analysis” (ICA), and “Clustering” 
(K-means).

Please note that a Multiband capture sequence delivers the set of images specified in the Charisma 
guidelines, including false-color images, all meant to be inspected and analyzed visually. You may use 
the Rainbow in-line Analysis Module for further analysis on a Multiband stack if you exclude/deselect 
the false-color images of the desired wavelengths from the Input list (see the step-by-step guide in the 
workflow chapters on pages 62, 64 and 66).

It is of basic importance that the workflow of capturing multi-spectral stacks is followed, as specified in 
this User Guide.  The steps of: Project, Recipe, Calibrate, Capture, Browse and Export need to be 
followed. For example, you cannot expect to reach any usable results by simply starting the capturing 
of images without having completed a proper calibration process.

We wish you all the best with your multi-spectral work,

Phase One
Cultural Heritage Team

Note that content and technical specifications are being reviewed and updated periodically, so please 
refer to the latest version or contact your Phase One CH partner for advice.
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Warnings and advice for proper use of the hardware for the Rainbow MSI System

1. WARNING: The illuminator includes ultraviolet LEDs. Whenever this wavelength is activated, it 
is mandatory that all personnel in the room shall wear personal eye protection with side shields to 
protect eyes and skin. You must put UV glasses on to prevent damage to your eyes.

2. For the best possible lighting conditions follow this advice: 
a. Please ensure that there is no light pollution from other light sources. In other words, only use 

the supplied light sources in an otherwise dark room.  
b. Please set up the lights with a 45-degree incident angle at a distance of between 1 to 2 m from 

the object matter.

3. To make the calibration stages work correctly, please make sure you have available:
a.  One clean sheet of A1 sized flat white paper or cardboard to perfect the Flat Field calibration. 

A background that resembles the intended scene. Please note that a completely dark back-
ground can result in issues with poor IR reflectance images (due to IR hot spot issue).

4. Please ensure that the computer will not go into a power saving mode by changing the settings in 
System Settings. If the computer goes to sleep during long exposure and calibration sequences, the 
MSI software will not be able to complete the task. 

5. Workflow Overview:
a. Set up the physical position of camera, filter wheel and lights.
b. Perform the calibration stages: Focus and Alignment, Flat Field Compensation and Exposure 

Compensation.
c. Use Live View to position and capture subject matter, repeatedly. This is quick and can be used 

continuously.
d. PLEASE NOTE: When changing the physical position of camera, filter wheel or lights: you must 

perform the calibration stages again, before capturing new subject matter.

6. To make the filter wheel run as quietly as possible, carefully tighten the friction screw at the bottom 
of the filter wheel. This may seem a little sensitive, but will lead to a smooth and reliable operation.

7. Basic considerations for positioning the camera and the filter wheel:
a. The iXG/iXH camera is mounted facing down at the top of the rail carrying the camera and filter 

wheel. With each lens, 72mm or 120mm, the iXG/iXH has a maximum extension for focusing.  
CAUTION: Please make sure to position the filter wheel outside the camera’s maximum exten-
sion of 21mm, so that when fully extended, the lens will not foul the filter wheel.

b. This procedure is recommended:
i. Select “Capture” in the MSI software to start Live View.
ii. Set the Live View focus tool to “Manual mode” and 

bring the lens to its maximum  
extension using the arrow-buttons.

iii. To avoid light falloff (vignetting), now position the 
filter wheel as close to the lens as possible, using the 
guide marks on the lens and shroud as seen in the 
illustration on the right.

iv. Make sure the shroud is in place to prevent light from 
entering the gap between the lens and the filter wheel.

8. Sensor cleaning: Please refer to procedure described as an appendix at the end of this document.
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Multiband Imaging

Hardware Setup for Multiband Imaging
Setup of the Multiband Dedo lights
Included equipment:

 • 2 x Multiband Dedo DLED7 UV 365nm (ultraviolet) 1
 • 2 x Multiband Dedo DLED7-D visible light (daylight) 2
 • 2 x Multiband Dedo DLED4-BI-IR 860nm/960nm (infrared) 3
 • 2 x Light support rail (for light stand) 4
 • 2 x USB-Switch 4 USB controlled power switch 5
 • 2 x Multiband Dedo DT4-BI power supplies (for IR LED-lights) 6
 • 4 x Multiband Dedo DT7 power supplies 7

The system consists of six Multiband Dedo LED lights – two DLED7-UV365 (UV - ultraviolet) lights, two 
DLED7-D visible lights and finally two DLED4-BI-IR (IR - infrared) lights. 

Four of the six supplied lights need to have filters mounted. UV-pass filters (dark colored) are mounted 
in front of the UV LED lights. IR-cut filters (light green) are mounted in front of the VISIBLE LED lights. 
These filters are stored in a small, folded pouch inside the supplied wheeled bag.

1 2 3

4

7

7

6

5
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It is important to set up the different LED lights so that the same type (UV, visible and IR respectively) 
mirror each other’s position on both sides of the capture area. The following way is how we 
recommend that you mount the LED lights on the supplied support rail on the stand with the stands 
placed on each side of the copy stand:

 • Facing the copy stand, mount the two UV lights onto the spigots closest to you. The UV lights are 
identified by a purple color band.

 • On the middle spigots, mount both of the visible spectrum lights. They are identified by a yellow 
color band. They should be approx. in line with the iXG/iXH camera.

 • Finally, mount the IR lights on the spigots farthest away from you. The IR lights are identified by a 
red color band.

Controlling the light beam angle
Make sure that the light beam is set to be fully flooded on all the lamps instead of set to a spot light. 
The angle of the light is adjusted by turning the colored ring on the lamp.

Correct light angle – full flood light:

Wrong light angle – spot light:



Page 8Rainbow Multispectral Imaging User GuideRainbow v2.3/User Guide v1.5

Connecting the Multiband Dedolight power supplies to the LED lights
The LED lights use different types of power supplies so please be aware of this as you connect them. 

The two UV LED lights (purple color band) and the two visible LED lights (yellow color band) need to 
be connected to the four power supplies labelled DT7. 

The two IR LED lights (red color band) need to be connected to the two power supplies labelled DT4-
BI. 
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Connecting the power for the LED lights
In order for the software to be able to turn the correct LED lights (UV, visible or IR) on and off 
automatically, the LEDs need to be connected to the two USB controlled power supplies in a specific 
order.

Each bank of LED lights (UV, visible and IR) should be connected 
to a USB-Switch power supply in the following order:

 • The UV light (purple band) goes in the first socket labelled 1
 • The Visible light (yellow band) goes in the middle socket 

labelled 2
 • The IR light (red band) goes in the third socket labelled 3

Each bank of three lights (UV, VIS and IR) should be connected to 
one USB-switch power supply.

Then connect the USB-Switch power supplies to the power 
outlet and the USB cables to the supplied USB control hub (see 
below).

The six power supplies can be secured to the light stands by using the supplied clamps or the 
integrated wired loops.

Adjust and position the Dedo light heads at approx. 45º to ensure good spread of light over the 
captured area. WARNING: You must wear protective glasses before you turn the UV lights on!

Setting brightness level and color
You have the ability to set the brightness level on Dedolight power supplies. In addition, the color can 
be adjusted on the DT4-BI labelled power supplies for the IR LED lights. These are controlled by knobs 
at the end of the power supplies.

Please ensure to set the brightness to the maximum level with the Dim-labeled knobs as well as 
adjusting the Color-labeled knob as shown on the images above. Set the Dim knobs all the way up to 
the max position and set the Color knob at a midway position.

1 2 3
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Assemble the Filter Wheel and iXG/iXH Camera

The filter wheel is mounted on the supplied rail together with the iXG/iXH camera. Attach it to the 
Phase One-labeled adjustable mount by using the supplied screws and Allen key:

The iXG/iXH camera attaches to the rail via the quick release mount.

Once the filter wheel and the iXG/iXH camera have 
been mounted on the rail, the setup should look 
like this:

Mount the rail with the filter wheel and iXG/iXH Camera on the copy stand.

Next, place the supplied shroud on top of the 
filter wheel. The purpose of the shroud is to 
ensure that no light is leaked into the area 
between the lens and the filter wheel.
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Please note that the iXG/iXH Camera has a clear glass filter fitted onto the sensor to be able to record 
UV and IR light waves outside the visible spectrum. This means that a filter must be used in front of the 
camera to control what light waves are recorded at different capture stages. This is what the supplied 
filter wheel accomplishes. 

Finally, attach the supplied power supply to the filter wheel and 
a power outlet and the USB cable from the filter wheel to the 
supplied USB hub. 
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Connecting the USB cables
Included equipment:

 • 1 x StarTech central USB Hub 1
 • 1 x power supply 2
 • 1 x USB cable 3

The automation of the system relies on the Rainbow software’s ability to control the LED lights, filter 
wheel and iXG/iXH Camera. This is facilitated by the use of USB connections added to the supplied 
central USB Hub.

In order to ensure a smooth and reliable operation, it is important to use the supplied USB Hub and to 
connect the USB cables from the iXG/iXH Camera, Filter Wheel and the lights to a specific USB port on 
the hub. Please connect the USB cables as follows:

Connect the Filter Wheel to port 1
Connect one Multiband Cleware USB switch to port 2
Connect the 2nd Multiband Cleware USB switch to port 3
Connect the iXG/iXH Camera to port 6

Connect the USB Hub to the power supply and to a USB port on the computer with the Rainbow 
software installed. Refer to page 14 for the software installation, which will also install the necessary 
drivers for controlling the Filter Wheel and the LED lights.

Please note connecting the hub to a USB-C port on the computer is recommended for best
performance.

The camera can also be connected directly to a free USB port on the computer.

1 32 6

1 23
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The Filter Wheel and Laptop suitcase

The filter wheel and rail are secured in the foam insert at the top of the MSI case. There is also room 
for a 17” laptop (not supplied) underneath the foam insert, so please remove it to access the laptop 
compartment as shown below. 
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Installation of the Rainbow MSI Software
The Rainbow MSI software comes with an easy-to-use installation file. Just double click on the 
Rainbow MSI.msi file and follow the six steps in the Rainbow MSI Setup Wizard. 

You may want to pay attention to the Destination Folder 
path in step three. If you have previous versions of the 
Rainbow MSI software installed, it is recommended to 
not overwrite the old version but instead ensure that the 
software is installed into a new path for the latest version, 
like \Rainbow MSI 2.3\. This way, you can still use the old 
version if you encounter any issues with the latest release. 

You can change the destination folder by clicking on the 
Change… button.

Once installed, a shortcut will be added to your Windows 
Desktop. You can also access the software from the Start Menu. 

Installation notes
 • The software will by default be installed under C: > Program Files (x86) > Phase One > Phase One 

Rainbow MSI 2.3. 
 • The application data will be installed under User > AppData > Local > Phase One > Rainbow MSI. 

This folder contains the logs and the saved recipes. 
 • Note that the AppData folder and its content are hidden by default on Windows. 

Project Folder Structure
The file structure of the project is set up with folder and subfolders as follows:
        

 • analysis_images folder
 • calibration folder
 • calibration_images folder

 » alignment subfolder
 » exposure subfolder
 » flat_field subfolder
 » focus subfolder

 • previews folder
 • processed_images folder
 • raw_images folder
 • thumbnails folder

The final files are saved in the processed_image folder and you also have the option to access the 
originally raw captured images, which are stored in the raw_images folder. 
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Rainbow MSI Software Introduction

Getting Started

To launch the Rainbow Multispectral Imaging software, double click on the application icon on the 
desktop. 

The software is designed with five workflow steps, with each step selected by clicking on a tab at the 
left of the screen named Project, Recipe, Calibrate, Capture and Browse.

Once you are done with capturing your image project files, you can inspect the finished files by 
clicking on Browse.

1

2

3

4

5
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Checking that all devices are connected and recognized
Before you start, ensure that all the devices (camera, lights and filter wheel) 
are properly connected and recognized. You can check this by looking at 
lower right corner under Devices where a solid white dot will indicate that a 
device is connected and ready to use. If there is an empty circle instead, the 
device is not properly connected or recognized.

It is possible to expand the device overview by clicking on the Devices box in lower right corner. This 
will let you inspect the current setup of the Eureka or Dedo Lights and the Filter Wheel in detail. Click 
again in the Devices box to close the expanded overview.

The first step is to create a new project or open an existing one. 
This is done by clicking on the Project tab at the left side of the 
screen. Please note that if a project was in use when you closed 
the software last time, it will automatically be reopened when you 
launch it.

1
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Multiband Imaging Operations 
Creating a New Project

1. Click on the Project tab.
2. Then click on the button New Project.
3. Type a name for the project in the window that appears. Click Browse to select the location where 

to save your project. It is saved in the Pictures folder as default. 
4. Finally, click OK to create the project. 

5. It will note that it currently contains zero stacks since no captures have been done yet.
6. If you instead want to open and continue on a previous project, just locate the project and click on 

it. If the project is not visible in the project tab, click on the Load Project button, then browse to 
its location on the computer, double-click to open the Project Folder and then click “Select Folder”.
Please note this can take a few seconds when loading Projects with large amounts of data.

7. If you need to delete a project, hover the mouse over the project frame and click on the cross icon.
Please note when you delete a project in this way, all images associated with that project are 
deleted from the computer hard drive.

2

3

4

1

6
7

5
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Selecting a Capture Recipe

1. Click on the Recipe tab at the left side of the screen.
2. Select a Recipe from the Recipe Preset drop-down menu at the top. The software comes with both 

Multiband (Dedo lights) and Narrowband (Eureka lights) presets so ensure you select Multiband 
which fits with the Dedo light setup.

3. Once a Recipe Preset is selected, the Recipe Editor will show a predefined list of capture 
sequences that is set up with different lights (visible, UV and IR) and filter combinations:

4. In the example above, the Recipe will go through six capture combinations noted under Step 
Name. The different combinations of lights and filters are as follows: 
VIS = Visible light with visible light pass filter. 
VIL = Visible light with IR pass filter. 
UVR = UV light with UV pass filter. 
UVL = UV light with Baader+BG39 filter. 
UVIL = UV light with IR pass filter. 
IRR = IR light with IR pass filter. 

1 2

3

4
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If you do not use a Preset, you will have to create these combinations of lights and filters yourself 
(Please see Creating your own Recipe below).

5. In the Recipe Editor, ensure that the lens aperture is set according to the selected recipe by click-
ing on the Aperture drop-down menu.

6. You can adjust the exposure time by clicking in the Shutter Speed row to modify these. This step 
is important to remember if you change the aperture in order to keep the exposure constant. 

Important note about Aperture, ISO and Shutter Speed

In the Recipe Editor you have access to the three parameters of the capture: Aperture, ISO and Shutter 
Speed. Please note that the Exposure Compensation is automatically calculated in the calibration 
process setting the exposure gain and the white balance for best possible exposure. This is done 
assuming that Aperture and ISO is kept constant as specified in the Recipe.

Should you want to work at, for example, a higher ISO you will need to start in the Recipe Editor by 
setting the new ISO and manually adjust Shutter Speeds up or down in 1/3 steps. Then, re-do the 
calibration process, which will calculate a new Exposure Compensation.

5

6
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Creating your own Recipe

1. Make sure that you haven’t selected a built-in recipe from the Recipe Preset drop-down menu to 
get a clean slate to work with. 

2. You now have to set up a sequence of captures with each their light, filter and shutter speed. Select 
the Multiband Dedo light type from the Device drop-down menu.

3. Select the light type (UV, IR or Visible light) from the Channel drop-down menu.
4. Choose the needed filter combination from the Filter drop-down menu. 
5. Finally, you also need to select the required exposure time from the Shutter Speed drop-down 

menu. 
6. You can name each of the individual captures in the sequence in the Step Name field to keep 

things organized.
7. The recipe will be saved automatically in the background as you start to work with the project. If 

you want to reuse the created recipe in another project later on, then please remember to save it to 
disk by clicking on Save. 

You can delete a created row in the Recipe by hovering the mouse over it and clicking on the cross 
icon.

4

71

2 3 56
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Calibration Process

A very important part of the Multi Spectral Imaging workflow is to do a Focus and Alignment 
calibration as well as calibrations for Flat Field Compensation and Exposure Compensation. This 
is needed to ensure a satisfactory capture and final image quality. The calibration processes are 
automated and will only require that you change a target for each step. These steps will be explained 
on the following pages.

It is important to point out that the resulting calibration is only valid for the setup of the lights and the 
distance from camera to the subject that you were using during the calibration process. 

If you move the lights or change the camera distance substantially, it is essential to redo the 
calibration process – otherwise the captured and processed images will not be a of a satisfactory 
quality. You can, however, reuse the current calibration if the distance from camera to subject is not 
changed substantially. This means that for example pages from a book can still be captured without 
issues with the current calibration.

Please note that the user interface might look like the application is frozen while the calibration 
processes are going on. This is normal behavior. 

Expected calibration times
The time to complete a calibration depends on the number of steps in the recipe and the selected 
shutter speeds.  The calibration times for a standard Multiband Recipe Preset are as follows:

 • Focus and Alignment Calibration – approximately 3 min. 20 sec.
 • Flat Field Compensation – approximately 1 min. 40 sec.
 • Exposure Compensation/White Balance – approximately 8 min. 10sec.

General Calibration Settings
You can change the general calibration settings by clicking on the settings icon in the upper right side 
of the software. 

Audible feedback
It is possible to choose whether you want an audible 
feedback to sound from the computer when a calibration 
process is completed. Here you can either choose a sound 
(Acoustic) or a voice (Speech) to indicate that the process 
has ended, or to turn the audible feedback off entirely (Off). 

The audible feedback is available so that if the screen is 
turned off during the calibration process you can tell when the process is done.

Blackout Mode
If you want the computer screen to turn off during the calibration process to ensure complete dark-
ness, please enable Blackout mode.

WARNING: From this stage on, you must wear UV protective glasses to prevent damage to your 
eyes!
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Adjusting camera distance before calibration

It is important to set the working distance between the camera and the subject matter before you 
start the calibration process. If you change the camera distance during the capture process, the 
calibration steps will have to be redone. Follow these steps to get the desired framing of the subject 
matter correct:

1. Click on the Capture tab to open Live View. 
2. Place the subject matter inside the frame. Then click on the subject for the camera to focus on it. 

The Live View feed will show you the same frame as the final capture. 
3. Change the distance of the camera on the copy stand to zoom in or out depending on whether 

you need a tighter framing or a wider framing. Keep an eye on the border of the subject matter.
4. Once you are satisfied with the framing of the subject matter, click on the Calibrate tab and 

continue on to the next chapter.  

Important note: In order to get the best results from the following calibration step, please make 
sure to position the lights such that the initial light coverage is as smooth as possible. If you place the 
lights, and especially the IR light, close to the repro table top and focused at the same point, you may 
be forcing a severe light fall off that makes it difficult to get the calibration steps consistent between 
the three reflection images IR-reflected, VIS-reflected, and UV-reflected for Multiband.

1
4

2

3
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Focus and Alignment Calibration

It is important to make the Focus and Alignment Calibration since the correct focus plane will 
change slightly depending on the used light wave (UV, visible light and IR) which means that the 
system will need to refocus for each light band. Technically, the system will obtain a correct focus for 
the visible light (Multiband) and make a scaling and alignment calibration based on the detection of 
the corners together with precalculated offsets for the other light waves.

1. Click on the Calibrate tab at the top left of the screen.
2. Click on the Focus and Alignment button to start Liveview.
3. Place the supplied checkerboard focus target on the copy stand. IMPORTANT: the whole 

checkerboard MUST be placed visibly inside the imaging area for the calibration to deliver correct 
results. 

4. Click on the green Continue button to start the Focus and Alignment calibration process. 

1 2 4

3
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Flat Field Compensation

The Flat Field Compensation process will ensure light uniformity on the images by calculating the 
light falloff and applying a correction. This will be done for each light/filter combination to ensure 
maximum image quality. 

1. Click on the Flat Field Compensation 1  button.
2. Then click on the green Continue 2  button.
3. Place a large white piece of paper or similar that covers the entire image area on the copy stand. 

Ensure that it is kept as flat as possible. Refer to the General Considerations section.
4. You can check whether the white paper is indeed covering the entire image frame by entering Live 

View. This is done by clicking on the Capture 4  tab. 
5. Once confirmed, select the Calibrate 5  tab again.
6. Make sure that all normal lights are turned off in the room so that it is completely dark.
7. Click on the green Continue 2  button to start the calibration process.
8. The computer screen will now turn off to ensure complete darkness if blackout option is selected 

in settings. The process will take approximately 1:40 minutes for a standard Multiband recipe. The 
screen will turn back on when the process is complete.

1
25

4
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Exposure Compensation and White Balance
It is necessary to perform an exposure calibration to get useful results with properly exposured 
captures. This process will also adjust the white balance automatically.

1. Click on the Capture tab to open Live View.
2. Place the subject matter inside the frame and the PTFE-target next to it.

3. Click on the Calibrate tab.
4. Click on the Exposure Compensation button.
5. Then click on the green Continue button. Verify that the PTFE-target is in place and click on the 

green Continue button again to start the calibration process.
6. The computer screen will now turn off to ensure complete darkness if the blackout option has 

been selected in settings and the camera will make a capture sequence corresponding to the se-
lected recipe.

7. The screen will turn back on and a preview will be displayed in the viewer. 
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8. You will now be asked to select the white and the black part of the PTFE. First select the white part, 
then the black.

9. Click on the green Continue button once you’re done.

10. The software will report as the adjustments are being made so that you can follow the progress: 
The process will take approximately 8 min. 10 sec. for a standard Multiband recipe.
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Handling failed Exposure Calibration
The Exposure Calibration might fail due to one or more steps being either underexposed or 
overexposed. If so, an error message will tell you what recommended shutter speed you should use 
instead. 

1. In the example above, it is recommended to try again with a shutter speed of 1m20s. Note the 
recommended shutter speed before moving to the next step.

2. Open the Recipe tab and change the shutter speed 3  according to the recommendations in the 
error warning. 

1
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4. Once you have changed the shutter speed, click on the Calibrate tab. Then click on Exposure 
Compensation 5  and finally redo the calibration by clicking on Approve 6 . The software will then 
only recalibrate the adjusted steps.

4
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Option 1.

In the “Create New Project” dialog box is a checkbox with the text “Reuse recipe/calibration from the 
current project”. Put a tick in the box if you want to reuse the recipe and calibrations from the previous 
Project.

This checkbox is only presented if there are calibrations present in the previously loaded project.

Option 2.

In each of the Recipe and Calibration boxes is a button with the text “Load Recipe/Calibration from 
previous Project”.

This button is only presented if there are calibrations present in the previously loaded project.

Please note that pressing this button will overwrite all existing recipe and calibrations that might be 
present in the current project.

Reuse Recipe/Calibration

This functionality is used for copying the Recipe and Calibrations from an existing Project to a new 
Project.

When reusing recipe and calibrations please make sure that the physical system setup has not 
changed since the original calibration. If, for instance, the camera distance or light source distance/
angles have changed – the calibration will not yield good results.

Recipe settings are closely associated with a set of calibrations and hence both the recipe and 
calibrations need to be reused in order to ensure a correct match.

There are two options for reusing recipe/calibration from a previous project.
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Using Live View, Focus and Capturing

Under the Capture tab it is possible to use Live View, autofocus and manual focus as well as  execute 
the Recipe (the capture sequence) that you have set up previously in the Recipe section.

1. Select the Capture tab or use the keyboard shortcut Spacebar to check for specific details in the 
subject by using the Live View feed. 

2. You can autofocus on any part of the subject by clicking once in the Live View image. The software 
will autofocus in the center of the live view image if you use the keyboard shortcut F.

3. If you double click in the Live View window, you will zoom into 100% on the subject. Double click-
ing again will return to the full screen Live View feed. It is also possible to use the scroll wheel on a 
mouse to zoom in and out. 

4. You can use the six focus nudge buttons under the Live View window to adjust the focus manually. 
The outer triple-arrow buttons are used for large steps, the double-arrow buttons for fine adjust-
ments, while the inner single-arrow buttons provide ultra-fine adjustment. The focus nudging 
buttons are always enabled, except when capturing.  
Please note that the subject might be thicker (closer to the camera) than the initial focus obtained 
during the Focus Calibration step that was done on a thin focus target paper. For this reason, you 
might need to refocus before doing a capture.

5. Pilot light will turn on the Dedo VIS light. This will help when you want to use manual focus, for 
instance. Once a capture starts, the light will be turned off, and then turned on automatically again 
once the capture is finished. The global keyboard shortcut for toggling the pilot light on and off is 
P. 
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6. The Live View feed will automatically pause after a certain time without any activity. Should that 
happen, just click on the play icon on the Live View feed to activate it again. 

7. It is possible to rotate the image 180 degrees. This option can come in handy if the image is cap-
tured upside-down as a result of the camera being mounted on a stand.  If you want the display 
and image capture on the iXG/iXH camera to follow the rotation of the Live View, you first need to 
set this manually on the camera by selecting Menu > Image Orientation > 180°.

8. You can display a grid with the Show Grid option as an aide to align the subject when in Live View.

9. You have the option to either let the software name the images within a stack, or name them 
manually with the Manual stack naming option. It is set to Automatic as default. If you select 
Manual, you will be prompted to enter a name and optionally Dublin Core Title, Creator, 
Description and Identifier for the captured stack of images.

10.  Once you are done and ready, click on the Capture button to execute the chosen Recipe. The cap-
ture and processing progress will then be indicated by two progress bars: 

The keyboard shortcut for starting a capture with the Capture tab open is Spacebar.
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Cancel Capture Sequence

After a capture sequence has been initiated, it is possible to cancel the capture sequence.

Once a capture sequence has been started, a cancel button appears next to the capture button.

This could be useful if a long sequence has been triggered and the user notices that the subject
matter has been wrongly positioned or something is missing from the scene.

Please be aware that this will cancel the ongoing capture sequence entirely and delete all folders and
files that might have already been produced by the given capture sequence.

Pressing the cancel button will break the capture as soon as possible – please note that this might
take some time, depending on the current exposure time, since ongoing actions need to be stopped 
and all system components, both software and hardware, need to be reset to their original state.

It is recommended to let the cancel operation complete before interacting further with the software.



Page 33Rainbow Multispectral Imaging User GuideRainbow v2.3/User Guide v1.5

Reviewing the captures

Once a capture sequence is completed, the image stack is saved and can be reviewed from within the 
software. This is how the Browser and Viewer part of the user interface works:

1. Each capture sequence will be displayed in a horizontal Browser row. 
2. Once you select a capture sequence 1 , the image stack will be displayed in a vertical Browser row. 

You can scroll up and down if there are many images in the stack.
3. If you click on an image in the stack, it will be displayed in the Viewer 4 .
4. If you double-click on the image in the Viewer or use the scroll wheel, you will zoom into 100% on 

the subject. Double clicking again or using the scroll wheel will return back to the full screen view.

Notice how the name of each capture sequence file mirrors what was entered in the Step Name of the 
Recipe.
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File handling

Rename Stack
You can rename a stack of images by right-clicking on
the master stack thumbnail and selecting Rename 
stack. After renaming, press Enter.

Reprocess Stack
You can reprocess a stack of images by right-clicking on 
the master stack thumbnail and selecting Reprocess 
stack.

Open in Explorer
It is possible to open a stack of images by right-clicking 
on the master stack thumbnail and selecting Open in 
explorer.

Delete
You can delete a stack of images by hovering the mouse 
over the master stack thumbnail and clicking on the 
cross icon.
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Opening the finished files

1. Once you are done with the capturing process, click on the Browse tab. 
2. The software will now open the folder with all the processed images, ready for you to inspect.

The processed files are saved as 16-bit uncompressed TIFFs.

1
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Narrowband Imaging

Hardware Setup for Narrowband Imaging

Light setup – Narrowband Eureka LED panels
Included equipment:

 • 2 x Narrowband Eureka multi-LED light panels.
 • 2 x Eureka power supplies
 • 2 x USB A-A cables

Setup of the Narrowband Eureka multi-LED light panels

Mount the two Narrowband Eureka multi-LED light panels on light stands and place them on each 
side of the copy stand so they are mirrored in position and have the same light angle. Ideally, they 
should be set up at a 45º angle to achieve a good spread of light over the capture area.
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Connect the two supplied Narrowband Eureka power supplies to the lights and a power outlet using 
the correct adapter for your country/region. Finally, connect the two USB cables to the supplied USB 
control hub (see later in the guide). 
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Assemble the Filter Wheel and iXG/iXH Camera

The filter wheel is mounted on the supplied rail together with the iXG/iXH camera. Attach it to the 
Phase One-labeled adjustable mount by using the supplied screws and Allen key:

The iXG/iXH camera attaches to the rail via the quick release mount.

Once the filter wheel and the iXG/iXH camera have 
been mounted on the rail, the setup should look 
like this:

Mount the rail with the filter wheel and iXG/iXH Camera on the copy stand.

Next, place the supplied shroud on top of the 
filter wheel. The purpose of the shroud is to 
ensure that no light is leaked into the area 
between the lens and the filter wheel.
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Please note that the iXG/iXH Camera has a clear glass filter fitted onto the sensor to be able to record 
UV and IR light waves outside the visible spectrum. This means that a filter must be used in front of the 
camera to control what light waves are recorded at different capture stages. This is what the supplied 
filter wheel accomplishes. 

Finally, attach the supplied power supply to the filter wheel and 
a power outlet and the USB cable from the filter wheel to the 
supplied USB hub. 
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Connecting the USB cables
Included equipment:

 • 1 x StarTech central USB Hub 1
 • 1 x power supply 2
 • 1 x USB cable 3

The automation of the system relies on the Rainbow software’s ability to control the LED lights, filter 
wheel and iXG/iXH Camera. This is facilitated by the use of USB connections added to the supplied 
central USB Hub.

In order to ensure a smooth and reliable operation, it is important to use the supplied USB Hub and to 
connect the USB cables from the iXG/iXH Camera, Filter Wheel and the lights to a specific USB port on 
the hub. Please connect the USB cables as follows:

Connect the Filter Wheel to port 1
Connect one Narrowband Eureka light to port 4
Connect the 2nd Narrowband Eureka light to port 5
Connect the iXG/iXH Camera to port 6

Connect the USB Hub to the power supply and to a USB port on the computer with the Rainbow 
software installed. Refer to page 40 for the software installation, which will also install the necessary 
drivers for controlling the Filter Wheel and the LED lights.

Please note connecting the hub to a USB-C port on the computer is recommended for best
performance.

The camera can also be connected directly to a free USB port on the computer.

1 54 6
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The Filter Wheel and Laptop suitcase

The filter wheel and rail are secured in the foam insert at the top of the MSI case. There is also room 
for a 17” laptop (not supplied) underneath the foam insert, so please remove it to access the laptop 
compartment as shown below. 
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Installation of the Rainbow MSI Software
The Rainbow MSI software comes with an easy-to-use installation file. Just double click on the 
Rainbow MSI.msi file and follow the six steps in the Rainbow MSI Setup Wizard. 

You may want to pay attention to the Destination Folder 
path in step three. If you have previous versions of the 
Rainbow MSI software installed, it is recommended to 
not overwrite the old version but instead ensure that the 
software is installed into a new path for the latest version, 
like \Rainbow MSI 2.3\. This way, you can still use the old 
version if you encounter any issues with the latest release. 

You can change the destination folder by clicking on the 
Change… button.

Once installed, a shortcut will be added to your Windows 
Desktop. You can also access the software from the Start Menu. 

Installation notes
 • The software will by default be installed under C: > Program Files (x86) > Phase One > Phase One 

Rainbow MSI 2.3. 
 • The application data will be installed under User > AppData > Local > Phase One > Rainbow MSI. 

This folder contains the logs and the saved recipes. 
 • Note that the AppData folder and its content are hidden by default on Windows. 

Project Folder Structure
The file structure of the project is set up with folder and subfolders as follows:
        

 • analysis_images folder
 • calibration folder
 • calibration_images folder

 » alignment subfolder
 » exposure subfolder
 » flat_field subfolder
 » focus subfolder

 • previews folder
 • processed_images folder
 • raw_images folder
 • thumbnails folder

The final files are saved in the processed_image folder and you also have the option to access the 
originally raw captured images, which are stored in the raw_images folder. 
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Rainbow MSI Software Introduction

Getting Started

To launch the Rainbow Multispectral Imaging software, double click on the application icon on the 
desktop. 

The software is designed with six workflow steps, with each step selected by clicking on a tab at the 
left of the screen named Project, Recipe, Calibrate, Capture, Browse and Export.

Once you are done with capturing your image project files, you can inspect the finished files by 
clicking on Browse.
Running a Narrowband session also gives you the option to Export to Paleo Toolbox (covered later 
in the user guide). 
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Checking that devices are online and working
Before you start, ensure that all the devices (camera, lights and filter wheel) 
are properly connected and recognized. You can check this by looking at lower 
right corner under Devices where a solid white dot will indicate that a device is 
connected and ready to use. If there is an empty circle instead, the device is not 
properly connected or recognized.

It is possible to expand the device overview by clicking on the Devices box in lower right corner. This 
will let you inspect the current setup of the Eureka or Dedo Lights and the Filter Wheel in detail. Click 
again in the Devices box to close the expanded overview.

The first step is to create a new project or open an existing one. 
This is done by clicking on the Project tab at the left side of the 
screen. Please note that if a project was in use when you closed 
the software last time, it will automatically be reopened when you 
launch it.

1
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Narrowband Imaging Operations 
Creating a New Project

1. Click on the Project tab.
2. Then click on the button New Project.
3. Type a name for the project in the window that appears. Click Browse to select the location where 

to save your project. It is saved in the Pictures folder as default. 
4. Finally, click OK to create the project. 

5. It will note that it currently contains zero stacks since no captures have been done yet.
6. If you instead want to open and continue on a previous project, just locate the project and click on 

it. If the project is not visible in the project tab, click on the Load Project button, then browse to 
its location on the computer, double-click to open the Project Folder and then click “Select Folder”.
Please note this can take a few seconds when loading Projects with large amounts of data.

7. If you need to delete a project, hover the mouse over the project frame and click on the cross icon.
Please note when you delete a project in this way, all images associated with that project are 
deleted from the computer hard drive.

2

3

4

1

6
7

5



Page 46Rainbow Multispectral Imaging User GuideRainbow v2.3/User Guide v1.5

Selecting a Capture Recipe

1. Click on the Recipe tab at the left side of the screen.
2. Select a Recipe from the Recipe Preset drop-down menu at the top. Ensure that you select 

Narrowband that fits with your Eureka light setup.

3. Once a Recipe Preset is selected, the Recipe Editor will show a predefined list of capture 
sequences that is set up with different lights (visible, UV and IR) and filter combinations.

4. In the example above, the Recipe will go through 16 capture combinations noted under Step 
Name. The Channel column notes the colors where UV = UV light and IR = IR light. The Filter 
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column controls the used filter where UV = UV pass filter and VIS = Visible light pass filter. 
If you do not use a Preset, you will have to create these combinations of lights and filters yourself 
(Please see Creating your own Recipe below).

5. In the Recipe Editor, ensure that the lens aperture is set according to the selected recipe by click-
ing on the Aperture drop-down menu.

6. You can adjust the exposure time by clicking in the Shutter Speed row to modify these. This step 
is important to remember if you change the aperture in order to keep the exposure constant. 

Important note about Aperture, ISO and Shutter Speed

In the Recipe Editor you have access to the three parameters of the capture: Aperture, ISO and Shutter 
Speed. Please note that the Exposure Compensation is automatically calculated in the calibration 
process setting the exposure gain and the white balance for best possible exposure. This is done 
assuming that Aperture and ISO is kept constant as specified in the Recipe.

Should you want to work at, for example, a higher ISO you will need to start in the Recipe Editor by 
setting the new ISO and manually adjust Shutter Speeds up or down in 1/3 steps. Then, re-do the 
calibration process, which will calculate a new Exposure Compensation.

5
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Creating your own Recipe

1. Make sure that you haven’t selected a built-in recipe from the Recipe Preset drop-down menu to 
get a clean slate to work with. 

2. You now have to set up a sequence of captures with each their light, filter and shutter speed. Select 
the Eureka light type from the Device drop-down menu for Narrowband.

3. Select the light type (UV, IR or Visible light) from the Channel drop-down menu.
4. Choose the needed filter combination from the Filter drop-down menu. 
5. Finally, you also need to select the required exposure time from the Shutter Speed drop-down 

menu. 
6. You can name each of the individual captures in the sequence in the Step Name field to keep 

things organized.
7. The recipe will be saved automatically in the background as you start to work with the project. If 

you want to reuse the created recipe in another project later on, then please remember to save it to 
disk by clicking on Save. 

You can delete a created row in the Recipe by hovering the mouse over it and clicking on the cross 
icon.
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Calibration Process

A very important part of the Multi Spectral Imaging workflow is to do a Focus and Alignment 
calibration as well as calibrations for Flat Field Compensation and Exposure Compensation. This 
is needed to ensure a satisfactory capture and final image quality. The calibration processes are 
automated and will only require that you change a target for each step. These steps will be explained 
on the following pages.

It is important to point out that the resulting calibration is only valid for the setup of the lights and the 
distance from camera to the subject that you were using during the calibration process. 

If you move the lights or change the camera distance substantially, it is essential to redo the 
calibration process – otherwise the captured and processed images will not be a of a satisfactory 
quality. You can, however, reuse the current calibration if the distance from camera to subject is not 
changed substantially. This means that for example pages from a book can still be captured without 
issues with the current calibration.

Please note that the user interface might look like the application is frozen while the calibration pro-
cesses are going on. This is normal behavior. 

Expected calibration times
The time to complete a calibration depends on the number of steps in the recipe and the selected 
shutter speeds.  The calibration times for a 16-step Narrowband  Recipe Preset are as follows:

 • Focus and Alignment Calibration – approximately : 6 min. 50 sec.
 • Flat Field Compensation – approximately 6 min. 30 sec.
 • Exposure Compensation/White Balance – approximately 6 min.

General Calibration Settings
You can change the general calibration settings by clicking on the settings icon in the upper right side 
of the software. 

Audible feedback
It is possible to choose whether you want an audible 
feedback to sound from the computer when a calibration 
process is completed. Here you can either choose a sound 
(Acoustic) or a voice (Speech) to indicate that the process 
has ended, or to turn the audible feedback off entirely (Off). 

The audible feedback is available so that if the screen is 
turned off during the calibration process you can tell when the process is done.

Blackout Mode
If you want the computer screen to turn off during the calibration process to ensure complete dark-
ness, please enable Blackout mode.

WARNING: From this stage on, you must wear protective UV glasses to prevent damage to your 
eyes!
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Adjusting camera distance before calibration

It is important to set the working distance between the camera and the subject matter before you 
start the calibration process. If you change the camera distance during the capture process, the 
calibration steps will have to be redone. Follow these steps to get the desired framing of the subject 
matter correct:

1. Click on the Capture tab to open Live View. 
2. Place the subject matter inside the frame. Then click on the subject for the camera to focus on it. 

The Live View feed will show you the same frame as the final capture. 
3. Change the distance of the camera on the copy stand to zoom in or out depending on whether 

you need a tighter framing or a wider framing. Keep an eye on the border of the subject matter.
4. Once you are satisfied with the framing of the subject matter, click on the Calibrate tab and 

continue on to the next chapter.  

Important note: In order to get the best results from the following calibration step, please make 
sure to position the lights such that the initial light coverage is as smooth as possible. If you place the 
lights, and especially the IR light, close to the repro table top and focused at the same point, you may 
be forcing a severe light fall off that makes it difficult to get the calibration steps consistent between 
the 16 reflected channels for Narrowband (2 UV, 11 visible and 3 IR).
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Focus and Alignment Calibration

It is important to make the Focus and Alignment Calibration since the correct focus plane will 
change slightly depending on the used light wave (UV, visible light and IR) which means that the 
system will need to refocus for each light band. Technically, the system will obtain a correct focus 
for the 550 Lime light with Narrowband and make a scaling and alignment calibration based on the 
detection of the corners together with precalculated offsets for the other light waves.

1. Click on the Calibrate tab at the top left of the screen.
2. Click on the Focus and Alignment button to start Liveview.
3. Place the supplied checkerboard focus target on the copy stand. IMPORTANT: the whole 

checkerboard MUST be placed visibly inside the imaging area for the calibration to deliver correct 
results. 

4. Click on the green Continue button to start the Focus and Alignment calibration process. 
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Flat Field Compensation

The Flat Field Compensation process will ensure light uniformity on the images by calculating the 
light falloff and applying a correction. This will be done for each light/filter combination to ensure 
maximum image quality. 

1. Click on the Flat Field Compensation 1  button.
2. Then click on the green Continue 2  button.
3. Place a large white piece of paper or similar that covers the entire image area on the copy stand. 

Ensure that it is kept as flat as possible. Refer to the General Considerations section.
4. You can check whether the white paper is indeed covering the entire image frame by entering Live 

View. This is done by clicking on the Capture 4  tab. 
5. Once confirmed, select the Calibrate 5  tab again.
6. Make sure that all normal lights are turned off in the room so that it is completely dark.
7. Click on the green Continue 2  button to start the calibration process.
8. The computer screen will now turn off to ensure complete darkness if blackout option is selected 

in settings. The process will take approximately 6 min. 30 sec. for a 16-step Narrowband recipe. 
The screen will turn back on when the process is complete.
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Exposure Compensation and White Balance
It is necessary to perform an exposure calibration to get useful results with properly exposured 
captures. This process will also adjust the white balance automatically.

1. Click on the Capture tab to open Live View.
2. Place the subject matter inside the frame and the PTFE-target next to it.

3. Click on the Calibrate tab.
4. Click on the Exposure Compensation button.
5. Then click on the green Continue button. Verify that the PTFE-target is in place and click on the 

green Continue button again to start the calibration process.
6. The computer screen will now turn off to ensure complete darkness if the blackout option has 

been selected in settings and the camera will make a capture sequence corresponding to the se-
lected recipe.

7. The screen will turn back on and a preview will be displayed in the viewer. 
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8. You will now be asked to select the white and the black part of the PTFE. First select the white part, 
then the black.

9. Click on the green Continue button once you’re done.
10. The software will report as the adjustments are being made so that you can follow the progress: 

The process will take approximately 6 min. for a 16-step Narrowband recipe.
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Handling failed Exposure Calibration
The Exposure Calibration might fail due to one or more steps being either underexposed or 
overexposed. If so, an error message will tell you what recommended shutter speed you should use 
instead. 

1. In the example above, it is recommended to try again with a shutter speed of 1/5s. Note the 
recommended shutter speed before moving to the next step.

2. Open the Recipe tab and change the shutter speed 3  according to the recommendations in the 
error warning. 
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4. Once you have changed the shutter speed, click on the Calibrate tab. Then click on Exposure 
Compensation 5  and finally redo the calibration by clicking on Approve 6 . The software will then 
only recalibrate the adjusted steps.
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Option 1.

In the “Create New Project” dialog box is a checkbox with the text “Reuse recipe/calibration from the 
current project”. Put a tick in the box if you want to reuse the recipe and calibrations from the previous 
Project.

This checkbox is only presented if there are calibrations present in the previously loaded project.

Option 2.

In each of the Recipe and Calibration boxes is a button with the text “Load Recipe/Calibration from 
previous Project”.

This button is only presented if there are calibrations present in the previously loaded project.

Please note that pressing this button will overwrite all existing recipe and calibrations that might be 
present in the current project.

Reuse Recipe/Calibration

This functionality is used for copying the Recipe and Calibrations from an existing Project to a new 
Project.

When reusing recipe and calibrations please make sure that the physical system setup has not 
changed since the original calibration. If, for instance, the camera distance or light source distance/
angles have changed – the calibration will not yield good results.

Recipe settings are closely associated with a set of calibrations and hence both the recipe and 
calibrations need to be reused in order to ensure a correct match.

There are two options for reusing recipe/calibration from a previous project.



Page 58Rainbow Multispectral Imaging User GuideRainbow v2.3/User Guide v1.5

Using Live View, Focus and Capturing

Under the Capture tab it is possible to use Live View, autofocus and manual focus as well as  execute 
the Recipe (the capture sequence) that you have set up previously in the Recipe section.

1. Select the Capture tab or use the keyboard shortcut Spacebar to check for specific details in the 
subject by using the Live View feed. 

2. You can autofocus on any part of the subject by clicking once in the Live View image. The software 
will autofocus in the center of the live view image if you use the keyboard shortcut F.

3. If you double click in the Live View window, you will zoom into 100% on the subject. Double click-
ing again will return to the full screen Live View feed. It is also possible to use the scroll wheel on a 
mouse to zoom in and out. 

4. You can use the six focus nudge buttons under the Live View window to adjust the focus manually. 
The outer triple-arrow buttons are used for large steps, the double-arrow buttons for fine adjust-
ments, while the inner single-arrow buttons provide ultra-fine adjustment. The focus nudging 
buttons are always enabled, except when capturing.  
Please note that the subject might be thicker (closer to the camera) than the initial focus obtained 
during the Focus Calibration step that was done on a thin focus target paper. For this reason, you 
might need to refocus before doing a capture.

5. Pilot light will turn on the Eureka Lime light. This will help when you want to use manual focus, for 
instance. Once a capture starts, the light will be turned off, and then turned on automatically again 
once the capture is finished. The global keyboard shortcut for toggling the pilot light on and off is 
P. 

1
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6. The Live View feed will automatically pause after a certain time without any activity. Should that 
happen, just click on the play icon on the Live View feed to activate it again. 

7. It is possible to rotate the image 180 degrees. This option can come in handy if the image is cap-
tured upside-down as a result of the camera being mounted on a stand.  If you want the display 
and image capture on the iXG/iXH camera to follow the rotation of the Live View, you first need to 
set this manually on the camera by selecting Menu > Image Orientation > 180°.

8. You can display a grid with the Show Grid option as an aide to align the subject when in Live View.

9. You have the option to either let the software name the images within a stack, or name them 
manually with the Manual stack naming option. It is set to Automatic as default. If you select 
Manual, you will be prompted to enter a name and optionally Dublin Core Title, Creator, 
Description and Identifier for the captured stack of images.

10.  Once you are done and ready, click on the Capture button to execute the chosen Recipe. The 
capture and processing progress will then be indicated by two progress bars: 

The keyboard shortcut for starting a capture with the Capture tab open is Spacebar.

7
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Cancel Capture Sequence

After a capture sequence has been initiated, it is possible to cancel the capture sequence.

Once a capture sequence has been started, a cancel button appears next to the capture button.

This could be useful if a long sequence has been triggered and the user notices that the subject
matter has been wrongly positioned or something is missing from the scene.

Please be aware that this will cancel the ongoing capture sequence entirely and delete all folders and
files that might have already been produced by the given capture sequence.

Pressing the cancel button will break the capture as soon as possible – please note that this might
take some time, depending on the current exposure time, since ongoing actions need to be stopped 
and all system components, both software and hardware, need to be reset to their original state.

It is recommended to let the cancel operation complete before interacting further with the software.
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Reviewing the captures

Once a capture sequence is completed, the image stack is saved and can be reviewed from within the 
software. This is how the Browser and Viewer part of the user interface works:

1. Each capture sequence will be displayed in a horizontal Browser row. 
2. Once you select a capture sequence 1 , the image stack will be displayed in a vertical Browser row. 

You can scroll up and down if there are many images in the stack.
3. If you click on an image in the stack, it will be displayed in the Viewer 4 .
4. If you double-click on the image in the Viewer or use the scroll wheel, you will zoom into 100% on 

the subject. Double clicking again or using the scroll wheel will return back to the full screen view.

Notice how the name of each capture sequence file mirrors what was entered in the Step Name of the 
Recipe.

1
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File handling

Rename Stack
You can rename a stack of images by right-clicking on
the master stack thumbnail and selecting Rename 
stack. After renaming, press Enter.

Reprocess Stack
You can reprocess a stack of images by right-clicking on 
the master stack thumbnail and selecting Reprocess 
stack.

Open in Explorer
It is possible to open a stack of images by right-clicking 
on the master stack thumbnail and selecting Open in 
explorer.

Delete
You can delete a stack of images by hovering the mouse 
over the master stack thumbnail and clicking on the 
cross icon.
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The Spectral Readout Tool (Narrowband only)
The Readout Tool is found under the Readout tab in the right pane of the software. Please note the 
Readout Tool can only be used with a full (16 image) narrowband reflectance image stack using filters 
for the UV and visible bands. For the UV365 and UV385 captures, use the UG1 visible block filter; for 
the 11 visible bands from 400nm to 660nm, use the BG38 UV/IR cut filter; for the IR bands from 730nm 
to 940nm, no filter is required. Luminescence images are not supported with the Readout Tool.

The Readout Tool is activated by pressing the 
’eyedropper’ button/icon. Once the eyedropper is 
selected, the software will load the 16 narrowband 
channels and ‘live readout’ is enabled. The color of 
the readout will adapt based on a pre-calibrated 
narrowband to RGB conversion.

Hovering the mouse in the image viewer will 
change the display of the graph to show the
current  ‘live readout’ at that point on the image.

Left clicking on the image will place a readout mark-
er on the image, fixed at that point.
A readout marker can be moved by clicking and 
dragging it with the left mouse button. The graph 
will update once the mouse button is released. Up 
to 9 readout markers can be placed on the image.
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Right clicking on a readout marker will present
three options:
• copy to clipboard
• delete that single readout marker
• delete all readout markers.

To distinguish between the line series in a chart, hovering the mouse over a readout marker will
highlight the relevant series in the graph.

Readout markers and vectors are stored continuously and will be available when changing the image 
stack or project, and when re-launching the application.
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Opening the finished files

1. Once you are done with the capturing process, click on the Browse tab. 
2. The software will now open the folder with all the processed images, ready for you to inspect.

The processed files are saved as 16-bit uncompressed TIFFs.

Export to Paleo (Narrowband only)
When you have been capturing with Narrowband where Eureka lights is part of the recipe, you have 
to option to export the project to Paleo, including file naming for direct transfer into Paleo Toolbox.

1. Click on the Export button. This will give you the option to name the scene to be exported as well 
as which stacks to include. 

2. Click on Export,when ready. 

1
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Analysis Module for Multi-spectral Stacks

The Basic Analysis Module provides an intuitive way to analyze any multi-spectral stack. With this 
module any stack (Multiband or Narrowband) can be analyzed directly in the software with some of 
the techniques most often used for image analysis. This feature lets you form an initial opinion about 
further analytical steps to be taken, typically in external software. 

Please note that Multiband capture and export delivers the set of images specified in the Charisma 
guidelines, including false-color images. These images can be inspected and analyzed visually.

You can use Analysis Module for further analysis on a Multiband stack if you exclude the false-color 
images of the desired wavelengths from the Input list (Step 5 in the step-by-step guides on the 
following pages). Just make sure that these are deselected in the list.

Special knowledge of the mathematics and statistics methods forming the kernel of these analysis is 
not required. Imagine the input stack as a cube with all the images layered and aligned, each captured 
with its specific wavelength. Looking through the stack from above in Rainbow MSI, each pixel 
position points through the layers to a set of values representing reflectance or luminescence response 
at the wavelengths captured. To speed up processing performance dramatically, the analysis methods 
are optimized to work on a randomized subset of the input values. This allows for complex analysis 
operations to be made quickly on vast amounts of data, a process that would otherwise be impossible.

There are three different techniques available for the analysis of stacks in Rainbow MSI version 2.3 
which will be covered on the following pages.
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Principal Component Analysis (PCA) introduction
This analysis method is used for statistically reducing the dimensions in diverse signal/image 
processing and machine learning applications to the “principal components”, hereby providing a good 
insight and overview of the data.

The main objective of PCA is to obtain a set of characteristics (principal components) that best 
summarize the large amount of data in the input stack. The first Principal Component contains the 
most well-defined characteristics drawn from all the different input data. Using PCA with multispectral 
imaging, the Principal Components are calculated with information from across all the spectral bands 
captured, ultraviolet, visible, and infrared.

The internal high-resolution representation of the pixel values provides for an option to define and 
control the most desired range as the basis for the image analysis on the screen, using sliders.
When interacting with these sliders it becomes intuitively apparent that certain materials show up 
concentrated in given ranges, and this interactive method can be used for isolating materials of 
interest.

The PCA analysis tool includes an option for selecting a colormap, that translates grayscale values to 
various color gradients, which serve to accentuate certain parts of the displayed image.

More info is available here: wikipedia.org/wiki/Principal_component_analysis
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Using Principal Component Analysis (PCA)

1) Select the stack that you want to analyze. Please note that you will be able to analyze all the images 
within that stack regardless of which part of the sequence you are currently viewing.

2) Ensure that you have selected the Analysis tab to get access to the feature. 

3) You can either choose to analyze the entire image or a part of it. If you want to analyze a specific 
area, click on the Mask icon and draw an area on the subject 4  with your mouse. If you want to delete 
the mask area again, click on the cross next to the Mask icon 3 .

5) From the Input list, select the captures from the stack that you want to include in the analysis. Click 
on the check box next to each capture to include them. If you want to include all the captures, click on 
Select All 6 . You can also deselect all in one go by clicking on Clear all 6 .

7) You are now ready to start the analysis by choosing the method. Click on PCA. 

8) The software will then do the calculations and list the different components or clusters in the 
Results list. Click on one of these in the list to show the analysis directly on the subject 4 .

9) You can change the color interpretation of the component or cluster analysis from Colormap drop-
down menu. Some will show the result more distinctly than others.

10) If the visual result of the analysis is still difficult to evaluate, you can move the end points of the 
slider to optimize the visual contrast and get a more clear interpretation.

Please note that if you create a new analysis by clicking on Cluster (K-Means), PCA or ICA 7  those 
will be added to the bottom of the Results list 8 . If you instead want to start all over on a clean state, 
click on Clear Results 11  first, then start the new analysis.

The step of exporting the analysis for external use will be covered later in this guide.
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Independent Component Analysis (ICA)

As the name states - this analysis method seeks to find independent components in the input data. 
In complex data analysis this is used for what is called “signal separation”. When imaging a historic 
document one can think of multiple signals or layers which are mixed: the paper, watermark(s), inks, 
mold, stains, hair, dust, etc.

The more distinct input images or channels the analysis method is set to work with, the more output 
signals/channels can be generated. It is useful to think about how many different signals/materials 
you think that your current subject matter contains and set the number of components accordingly. 
Try incrementing the number in subsequent runs and find the “sweet spot”. Sometimes the results can 
come as a surprise, and quite different from what you initially thought.

More info is available here: wikipedia.org/wiki/Independent_component_analysis
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Using Independent Component Analysis (ICA)

1) Select the stack that you want to analyze. Please note that you will be able to analyze all the images 
within that stack regardless of which part of the sequence you currently are viewing.

2) Ensure that you have selected the Analysis tab to get access to the feature. 

3) You can either choose to analyze the entire image or a part of it. If you want to analyze a specific 
area, click on the Mask icon and draw an area on the subject 4  with your mouse. If you want to delete 
the mask area again, click on the cross next to the Mask icon 3 .

5) From the Input list, select the captures from the stack that you want to include in the analysis. Click 
on the check box next to each capture to include them. If you want to include all the captures, click on 
Select All 6 . You can also deselect all in one go by clicking on Clear all 6 .

7) You are now ready to start the analysis by choosing the method. Click on ICA. 

8) The software will then do the calculations and list the different components or clusters in the 
Results list. Click on one of these in the list to show the analysis directly on the subject 4 .

9) You can change the color interpretation of the component or cluster analysis from Colormap drop-
down menu. Some will show the result more distinctly than others.

Please note that if you create a new analysis by clicking on Cluster (K-Means), PCA or ICA 7  those 
will be added to the bottom of the Results list 8 . If you instead want to start all over on a clean state, 
click on Clear Results 10  first, then start the new analysis.

The step of exporting the analysis for external use will be covered later in this guide.
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Clustering (K-means)

In the context of image analysis, Cluster analysis or clustering is the task of grouping a set of pixel-ob-
servations in such a way, that the properties of pixel-observations in the same group (called a cluster) 
are more similar (in some sense) to each other than to those in other groups (clusters). Clustering is 
a main task of exploratory data analysis, and a common technique for statistical data analysis, used 
in many fields, including image analysis, pattern recognition, and bioinformatics. K-means clustering 
groups the pixel-observations into ”k” number of clusters, in which each observation belongs to the 
cluster with the nearest mean (cluster centers or cluster centroid), serving as a model of the cluster. 

Cluster analysis as such is not an automatic task, but an iterative process of knowledge discovery or 
interactive multi-objective optimization that involves trial and error. It is often necessary to modify 
model parameters, like the number of clusters, until the result achieves the desired properties of the 
analysis. 
The correct choice of k is often ambiguous, but intuitively the optimal choice of k will strike a balance 
between maximum compression of the data using a single cluster, and maximum accuracy by assign-
ing each data point to its own cluster.

More info is available here: wikipedia.org/wiki/K-means_clustering
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Using Clustering (K-means)

1) Select the stack that you want to analyze. Please note that you will be able to analyze all the images 
within that stack regardless of which part of the sequence you currently are viewing.

2) Ensure that you have selected the Analysis tab to get access to the feature. 

3) You can either choose to analyze the entire image or a part of it. If you want to analyze a specific 
area, click on the Mask icon and draw an area on the subject 4  with your mouse. If you want to delete 
the mask area again, click on the cross next to the Mask icon 3 .

5) From the Input list, select the captures from the stack that you want to include in the analysis. Click 
on the check box next to each capture to include them. If you want to include all the captures, click on 
Select All 6 . You can also deselect all in one go by clicking on Clear all 6 .

7) You are now ready to start the analysis by choosing the method. Click on Cluster (K-Means). 

8) The software will then do the calculations and list the different components or clusters in the 
Results list. Click on one of these in the list to show the analysis directly on the subject 4 .

9) You can change the color interpretation of the component or cluster analysis from Colormap drop-
down menu. Some will show the result more distinctly than others.

Please note that if you create a new analysis by clicking on Cluster (K-Means), PCA or ICA 7  those 
will be added to the bottom of the Results list 8 . If you instead want to start all over on a clean state, 
click on Clear Results 10  first, then start the new analysis.

The step of exporting the analysis for external use will be covered later in this guide.
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Exporting the Analysis Results

1)  Once you are satisfied with an analysis, select the component or cluster in the Results list that you 
want to export. You can only select and save one at a time.

2) Click on the Save Result button. The TIFF file is then saved in the Project Folder within the subfolder 
“Analysis_Images”. 

3) If you want to verify the saved result, click on the Browse tab, find the “Analysis_Images” folder for 
your project and open the image in an external software.

Please note that in addition to the TIFF files, Rainbow MSI will also save a json-file in the “Analysis_
Images” folder with metadata information specifying the analysis-method, region-of-interest, etc. 

The saved TIFF files are named automatically using the method name, component/cluster number and 
an additional “edit” designator. The “edit” designator makes it possible to save multiple different edits 
of a single analysis result to cover different colormaps and value ranges.

Many popular platforms and software environments offer tools for statistical analysis of multi-variate 
recordings or captures. They include ImageJ + Paleo Toolbox, MATLAB and more.

1
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Metadata handling within Rainbow MSI

Metadata content and implementation within Rainbow MSI
The metadata of each image captured with Rainbow MSI are all stored (embedded) in the raw file and 
in the processed TIFF files. The Metadata types of EXIF, IPTC, XMP are used to contain the following 
elements:

 • EXIF data describing the camera system: 
 » EXIF in TIFF IFD (Image File Directory)

 • Project, Object: 
 » Within the Dublin Core namespace of XMP 

 • Capture Software: 
 » Within the Rainbow Namespace of XMP 

 • Illumination: 
 » Within the Rainbow Namespace of the XMP 

 • Filter and filter setup: 
 » Within the Rainbow Namespace of the XMP 

The metadata can be inspected using a standard metadata viewer “ExifTool”. Here follows an example.
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Typical uses of the metadata include: 
i. Extracting/copying relevant metadata from the image files to a central database from 

which selections, filtering and sorting can be performed.
ii. On-line Viewer with capabilities to search, select and sort images of a specific kind.

Example of metadata in the Phase One Rainbow MSI namespace:
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Troubleshooting

1 Before launching the Rainbow application: Please make sure that all devices are connected 
and powered ON.

In general, never disconnect or connect any device while the Rainbow software is running. In case 
you have connected a device with the Rainbow software ON, the device may not be detected by the 
application. To resolve the issue: close and restart the application. 

2 Verifying that the system is ready for use

Before you start working, please ensure that all the devices (camera, lights and filter wheel) are 
properly connected, powered and recognized. 

The Devices window in lower right corner shows all active USB connections.

To check that the devices are correctly powered 
and ready for use, please check the expanded 
Devices detail window by clicking on the 
Devices window. This will let you inspect the 
current status of the Eureka Lights, the Filter 
Wheel and the Dedo Lights in detail. Click 
again in the Devices detail window to close 
the expanded overview. To check that the 
camera is ready, click the Capture Tab in upper 
left corner, which displays what the camera is 
“seeing” in live view mode.

3 Adjusting ISO or Aperture after an initial completed calibration.

In the Recipe Editor you have access to the three parameters of the capture: Aperture, ISO and 
Shutter Speed. Please note that the Exposure Compensation is automatically calculated in the 
calibration process setting the exposure gain and the white balance for best possible exposure. This is 
done assuming that Aperture and ISO is kept constant as specified in the Recipe.

Should you want to work at, for example, a different ISO or a different Aperture you will need to start 
in the Recipe Editor by setting the new ISO or Aperture values. Then adjust all Shutter Speeds up or 
down in 1/3 steps. Hereafter, re-do the Flat Field calibration and the Exposure Calibration process.

Process completion feedback
Audio: In the top right menu, under General Settings, it is possible to choose whether you want 
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audible feedback from the computer when a calibration process is completed. You can choose a sound 
(Acoustic) or a voice (Speech) to indicate that the process has ended, or to turn the audible feedback 
off entirely (Off).

The audible feedback is available to signal when a step in the process is done.

Pilot light: In the Capture Tab click the Pilot Light button to turn on the Pilot light when the process is 
done. The keyboard shortcut “P” turns the Pilot light function ON / OFF.

4 Why does the Focus and Alignment calibration stops when working with 120mm?

The camera position may be outside the focusing range of the camera. Please enter the Capture tab 
and check if the camera is able to focus – either in manual or autofocus mode.

5 Why does the Focus and Alignment calibration not finish correctly?

Please make sure that the checkerboard target is correctly aligned, almost parallel to the image frame.

6 Why does the Camera not enter Live View?

a. Please make sure that other applications on the computer are not exercising the camera (for 
example Capture One).
b. Contact to the camera may be lost. Please turn the camera OFF and ON and restart the Rainbow 
application.

7 Where do I find the files from the captured stack?

Select the image stack you wish to find, and then click the Browse tab for Explorer window. 

8 Where do I find the image metadata?

The metadata is embedded in the image files – both the raw and the processed TIFF files. Please check 
the User Guide for details on the metadata content and structure.

9 How long does it take to calibrate?

The time to complete a calibration depends on the number of steps in the recipe and the selected 
shutter speeds. The duration of a calibration run for a full Recipe Preset are approximately as follows (if 
your setup requires long exposure times the calibration duration increase accordingly).

Narrowband Calibration (16 recipe steps)
 • Focus and Alignment: 6min 50sec.
 • Flat Field Compensation: 6min 30sec.
 • Exposure Compensation: 6min. 

Multiband Calibration Standard recipe.
 • Focus and Alignment: 3min 20sec.
 • Flat Field Compensation: 1min 40sec.
 • Exposure Compensation: 8min 10sec
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Project Folder Structure
The file structure of the project is set up with folder and subfolders as follows:
        

 • analysis_images folder
 • calibration folder
 • calibration_images folder

 » alignment subfolder
 » exposure subfolder
 » flat_field subfolder
 » focus subfolder

 • previews folder
 • processed_images folder
 • raw_images folder
 • thumbnails folder

You can concentrate fully on the final files in the processed_image folder, but you also have the 
option to inspect the originally raw captured images in the raw_images folder. 

Metadata Structure
The included Metadata contains a basic structure of:

 • Project, Object: Dublin Core in XMP
 • EXIF data describing the camera system: EXIF in XMP 
 • Capture Software: Rainbow Namespace in XMP
 • Illumination: Rainbow Namespace in XMP
 • Filter and filter setup: Rainbow Namespace in XMP

The included metadata will be added to the TIFF header of the image files and all metadata in the 
TIFF file are available as XMP. Please use an XMP enabled software like EXIF tool to access and read all 
metadata.

Example: Metadata displayed in UI on monitor for each Rainbow image:
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Example: EXIF metadata as seen by an XMP enabled EXIF tool

Versioning
This edition of the MSI User Guide is based on software version 2.3

Notice of Liability
The information in this guide is provided “as is”. Content and technical specifications are being 
reviewed and updated periodically, so please refer to the latest version or contact your Phase One CH 
partner for advice.
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Appendix

Assemble the Filter Wheel 

Included equipment :
 • 1 x Filter Wheel 
 • 1 x Filter carousel 
 • 1 x UG1 Visible block Filter
 • 1 x BG38 UV/IR Cut Filter
 • 1 x BG39 UV/IR Cut Filter
 • 1 x Baader UV/IR Cut/L Filter
 • 1 x RG830nm IR Pass Filter
 • 1 x Power supply 
 • 1 x USB cable 
 • 1 x Mounting Rail (for filter wheel and iXG/iXH 

Camera) 

Service the Filter Wheel  
The supplied motorized 2-inch filter wheel comes 
with a 5-position carousel that includes four 
filters. The filters have been assembled in the filter carousel before 
packaging to ensure that they are installed in the correct order. 

Warning: Do not touch the filter wheel while it is turned on. If you 
have to adjust it, you must first switch it off by disconnecting the 
USB cable. Then reconnect the USB once you are done.

In case you need to exchange a filter, they need to be assembled in 
the following order in the carousel:
 1   No filter
 2   UG1 Visible block filter
 3   BG38 UV/IR Cut filter
 4   RG830 IR Pass filter
 5   Baader UV/IR Cut/L filter and BG39 UV/IR cut filter

One of the wheel positions uses no filter as this is used to focus and 
use Live View etc. with the iXG/iXH Camera. 

The carousel has been inserted into the filter wheel to protect it 
during transport and it is thus ready to use. You can remove (and re-
insert) the filter carousel by first loosening the friction screw at the 
bottom of the filter wheel, and then loosening the knob at the top 
corner of the filter wheel and opening the cover. The carousel can 
then be slid in or out, but be careful not to touch or damage the fil-
ters while doing so.  After reinserting the filter carousel, first tighten 
the knob at the top corner of the filter wheel, and lastly tighten the 
friction screw at the bottom of the filter wheel.
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Recommended PC configuration
 
Processor:  Intel i7 processor or later, with multiple cores and 8MB or greater cache
Memory:  Minimum 32GB GB RAM (Increasing to 64GB will give improved performance, especially for 
analysis-heavy projects)
Storage: 1TB SSD hard disk or larger
Graphics card:  A high quality graphics card with powerful GPU performance is recommended for 
optimum performance
Operating System: Windows 10
Minimum 2 free USB ports
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Cleaning the sensor on the camera

Phase One iXG/iXH Camera 

Sensor Cleaning Procedure 
Ver.  1.2 

Phase One 2014-2018 90040957
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Phase One iXG/iXH Camera    Sensor Cleaning Procedure 

3 

Introduction 
This procedure shows how to clean the sensor on iXG/iXH camera.

The procedure is done in four steps: 

1. Removing the lens
2. Cleaning the camera interior and sensor module
3. Reassembling the camera body
4. Mounting the lens

Required tools 
Before you start, make sure that you have the following: 

• A clean, dry place to perform the service

• Hex #2.5mm screwdriver

 Torque handle set to 70cNm

 2.5mm x 100mm Hex head bit
• Phase One cleaning kit
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Phase One iXG/iXH Camera    Sensor Cleaning Procedure 

4 

Dismounting a Lens from the iXG/iXH Camera 
Lenses on the iXG/iXH series of cameras are easily dismounted.

NOTE: Ensure that you only dismount lenses in a clean environment. Place the detached lens 
on a soft cloth on the table to avoid scratching the lens. 

To dismount the lens: 

 Release the lens' locking levers.

 Remove the lens by pulling it gently away from the camera.

NOTE: If no lens is being mounted, ensure that the camera is stored in a way that protects it 
from dust, moisture and other damage. When the iXG/iXH camera is mounted facing down, 
always make sure (double check) that the lens is well secured by having the lens locking 
levers engaged. 

 Cover the front of the camera to prevent damage to the sensor.

 With a 2.5mm hex screwdriver, release the four camera module screws and lift
the entire camera body, place it on a clean surface.

Note: Make sure that the sensor module is well protected.
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Cleaning the Camera’s Sensor 

 Locate the small plastic wiper and identify the size that fits your sensor size.

 Fold one cloth and fold this over the wiper so that you have two layers of
cloth.

 Apply 2-3 drops of Eclipse fluid to the edge of the folded cloth.
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 In one move, swipe the surface of the sensor in one direction from start to
finish.

 Inspect the sensor and check to see if it is clean by holding it near a light. And/
or with a magnifying glass

If necessary, move the cloth layer one centimeter on the wiper and repeat the 
process. Never swipe twice with the same area of the cloth. 
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Reassembling the Camera Body in Place 

 Realign the camera body into place.

 Tighten the captive screws with a torque of 70cNm.

Mounting a Lens 
NOTE: Before mounting or dismounting a lens, ensure that the power cable is not attached to 
the camera.

 Place the Lens over the iXG/iXH camera body and guide it into position 
against the camera body using the two large positioning pins.
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 Close the Lens locking levers.

Note: The Lens is a-symmetrical, and can only be fitted in ONE position.

 Replace the lens, take and inspect image. We recommend photographing a
uniform grey or white paper or an image that is diffused by holding an opaque
filter in from of the lens

 Repeat the above steps as necessary until the sensor is clean
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